Assignment 3

This week “work through” Excel Unit H, Analyzing
Table Data. To “work through” means reading
and performing all hands-on exercises. The
exercises give detailed step-by-step instructions
with corresponding screen shot figures of the
Excel interface tabs, menus, toolbars, dialog
boxes, and correct output. You should perform all
of these to learn how to complete each skill.

Objectives

Students will have mastered the material in Excel Unit H when they can:

Filter a table

Create a custom filter

Filter a table with Advanced Filter
Extract table data

Look up values in a table
Summarize table data

Validate table data

Create subtotals

Unit Study Tips

Custom Filtering

When specifying criteria in the Custom Filter dialog box, you can use the ?
wildcard to represent any single character and the * wildcard to represent any
series of characters.

Conditional Formatting

You can apply conditional formatting to table cells in the same way that you can
format a range of worksheet data. You can add multiple rules by clicking the
Home tab, clicking the Conditional Formatting button in the Styles group, then
clicking New Rule for each additional rule that you want to apply. You can aiso
add rules using the Conditional Formatting Rules Manager, which displays all of
the rules for a data range. To use the Rules Manager, click the Home tab, click
the Conditional Formatting button in the Styles group, click Manage Rules, then
click New Rule for each rule that you want to apply to the data range.



Using advanced formatting options

You can emphasize top or bottom ranked values in a field using conditional
formatting. To highlight the top or bottom values in a field, select the field data,
click the Conditional Formatting button on the Home tab, point to Top/Bottom
Rules, select a Top or Bottom rule, if necessary enter the percentage or number
of cells in the selected range that you want to format, select the format for the
cells that meet the top or bottom criteria, then click OK. You can also format your
worksheet or table data using icon sets and color scales based on the cell
values. A color scale uses a set of two, three, or four fill colors to convey relative
values. For example, red could fill cells to indicate they have higher values and
green could signify lower values. To add a color scale, select a data range, click
the Home tab, click the Conditional Formatting button in the Styles group, then
point to Color Scales. On the submenu, you can select preformatted color sets or
click More Rules to create your own color sets. lcon sets let you visually
communicate relative cell values by adding icons to cells based on the values
they contain. An upward pointing green arrow might represent the highest values,
and downward-pointing red arrows could represent lower values. To add an icon
set to a data range, select a data range, click the Conditional Formatting button
in the Styles group, then point to Icon Sets. You can customize the values that
are used as thresholds for color scales and icon sets by clicking the Conditional
Formatting button in the Styles group, clicking Manage Rules, clicking the rule in
the Conditional Formatting Rules Manager dialog box, then clicking Edit Rule.

Understanding the criteria range and the copy-to location

When you define the criteria range and the copy-to location in the Advanced
Filter dialog box, Excel automatically creates the names Criteria and Extract for
these ranges in the worksheet. The criteria range includes the field names and
any criteria rows underneath them. The extract range includes just the field
names above the extracted table. You can select these ranges by clicking the
Name box list arrow, then clicking the range name. If you click the Name
Manager button in the Defined Names group on the Formulas tab, you will see
these new names and the ranges associated with the names.

Using the VLOOKUP, HLOOKUP and MATCH functions

The VLOOKUP (Vertical Lookup) function is useful when your data is arranged
vertically, in columns. The HLOOKUP (Horizontal Lookup) function is useful
when your data is arranged horizontally, in rows. HLOOKUP searches
horizontally across the upper row of a table until it finds the matching value, then
looks down the number of rows you specify. The arguments for this function are
identical to those for the VLOOKUP function, with one exception. Instead of a
Col_index_number, HLOOKUP uses a Row_index_number, which indicates the
location of the row you want to search. For example, if you want to search the
fourth row from the top, the Row_index_number should be 4.



If you want to find only the closest match for a value, enter TRUE in the Range
lookup text box. However, this can give misleading results if you are looking for
an exact match. If you use FALSE and Excel can't find the value, you see an
error message.

You can use the MATCH function when you want the position of an item in a
range. The MATCH function uses the syntax: MATCH

(lookup_value,lookup array,match_ type) where lookup_value is the value you
want to match in the lookup_array range. The match_type can be 0 for an exact
match, 1 for matching the largest value that is less than or equal to lookup_value,
or -1 for matching the smallest value that is greater than or equal to
lookup_value.

Data Validation: restricting cell values and data length

In addition to providing an in-cell drop-down list for data entry, you can use data
validation to restrict the values that are entered into cells. For example, if you
want to restrict cells to values less than a certain number, date, or time, click the
Data tab, click the Data Validation button in the Data Tools group, and on the
Settings tab, click the Allow list arrow, select Whole number, Decimal, Date, or
Time, click the Data list arrow, select less than, then in the bottom text box, enter
the maximum value. You can also limit the length of data entered into cells by
choosing Text length in the Allow list, clicking the Data list arrow and selecting
less than, then entering the maximum length in the Maximum text box.

Data Validation: adding input messages and error alerts

You can customize the way data validation works by using the two other tabs in
the Data Validation dialog box: Input Message and Error Alert. The Input
Message tab lets you set a message that appears when the user selects that
cell; for example, the message might contain instructions about what type of data
to enter. On the Input Message tab, enter a message title and message, then
click OK. The Error Alert tab lets you set one of three alert levels if a user enters
invalid data. The Information level displays your message with the information
icon but allows the user to proceed with data entry. The Warning level displays
your information with the warning icon and gives the user the option to proceed
with data entry or not. The Stop level, which you used in this lesson, displays
your message and only lets the user retry or cancel data entry for that cell.

Graded Exercises to be Submitted

» Independent Challenge 1, Jams, pages Excel 196-197. Omit the
Advanced Challenge Exercise part of the exercise.

» Independent Challenge 2, Paw Tags, pages Excel 197-198. Omit the
Advanced Challenge Exercise part of the exercise.



» Independent Challenge 3, Gifts, pages Excel 198-199. Omit the
Advanced Challenge Exercise part of the exercise.

Turn in each completed exercise to me using the assignment “delivery boxes” on
the Moodle course site in the Week 4 section.

For Assignment 4, you will find these 4 “delivery boxes” in the Week 4 section:
v Jams
v Paw Tags
v Gifts

A solution printout (in PDF format) is provided for each of the above files.

Compare your output to the solution printout to gauge correctness. The printout
identifies the items that will be checked in your submitted file.

Note that turning in assignment files to be graded by email attachment is not
acceptable. Use of the Moodle assignment “delivery boxes” enables recording of
grades and feedback on the Moodle course website.

Exercises submitted by midnight Thursday will be graded for feedback purposes
by midnight Friday. Errors may be corrected and exercises resubmitted by
midnight Saturday for full credit.

These problems are due according to the schedule given in the course syliabus,
Independent Challenges 1, 2, and 3 are due by next Saturday evening. Note that
the college requires a 20% penalty be imposed for all work submitted late in
online courses.

As always, contact me by email if you have any questions or problems. If you
have a question about a specific Excel exercise, you may attach your Excel file to
your email. If you wish me to call you, then include your phone number in the
email.
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Jam Labei
T:pperary Ranch
Tipperary Ranch -
Tipperar‘y Ranch -
Cork Estate
Gal way Estate
Galway Estate
Wexford Hms
“JVexford Hnlls
‘Wexford Hills
Kerry Lane
Kerry Lane ;
Kerry Lane

. Type of Jam

Gooseberry
‘Blackberry
Rhubarb

~ Gooseberry
‘Blackberry
ERhubarb
‘Goaseberry

- Rhubarb

~ Blackberry
‘Gooseberry
‘Blackberry
‘Rhubarb

Sl
~Medium
Small
Small
 smail
- Small
Small
~Small
‘Medium
‘Medium

Small

Medium

Umt Pnce

MM My mﬂm

575
6.00

6.50

575
525

6.25

575

525

575
725

6.55

7.55

~ Quantity

6
11
8;
12
11
21
31
15
18
12
24

m mm mm

otat

,34 50
66. OO
32 50
46.00
63.00
68.75

€120.75

€162.75
€ 8625
€ 130.50

€ 7860

€181.20
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o o C 4Month
: ' f < Order

‘Epicurean Delights _
‘AllFoods
‘Epicurean Delig
‘Souvenir Trade

Souvenir Trade
) Besi $eliers

‘Readers

‘Best Sellers
-Souvenir Trade
BestT
‘Souvenir Trade
Souvenir Trade P
BestT

kuand Crosswords  9/1
Vermont cookbooks

Best Sellers
Sauven
BestT
‘Alimart
Allmart
Allmart

‘Allmart
Alimart
Alimart

107172010 Personal
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excel Vlookup Tutorial with eExamples for Dummies rpage 1 of

A Video: How to use the VLOOKUP function {exact match)

Video: How to use the VLOOKUP function {closest match}

Using Viookup to Match Lists (And: Getting rid of the #N/A error)

IEE 3z

t Salesperson January Safes February Sales
e =

¥

i

o f
"5 oor

o

Samantha

If you use a spreadsheet,
you should watch
this 1 minute video.
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Yas Carcel Help
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Settings  Input Message  Error Alert

Ignore blank
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' ¥arning M

This cell acoapts valuss bebween § and 3,

ou can dlick Yes to enter the number you byped
and continus filling aut this worksheet, click Mo
to edit vour entry, or dick Cancel to bype a
different number,

Continue?

Cancel Help

http://office.microsoft.com/en-us/excel-help/appliy-data-validation-to... 10/13/2013



Apply data validation to cells - Excel - office.com rpage 4 of 11

fow 1o han

hitp://ofFFice.microsoft.com/en-us/excel-help/apply-data-validation-to... 10/13/2013



page 5 of 11

apply data validation to cells - Excel - Office.com

10/13/2013

.microsoft.com/en-us/excel-help/apply-data-validation-to...

//office

http



Apply data validation to cells - Excel - Office.com pPage 6 of 11

http://office.microsoft.com/en-us/excel-help/apply-data-validation-to... 10/13/2013



Apply data validation to cells - Excel - Office.com page 7 of 11

http://office.microsoft.com/en-us/excel-help/apply-data-validation-to... 10/13/2013



Apply data validation to cells - Excel - office.com page 8 of 11

htto://ofFice.microsoft.com/en-us/excel-help/apply-data-validation-to... 10/13/2013



page 9 of 11

apply data validation to cells - Excel - office.com

P
el

cel to

13/2013

/

~to... 10,

1on

ft.com/en-us/excel-help/apply-data-validat

TCe.mMICroso

2/ /ofFi

http



Apply data validation to cells - Excel - office.com page 10 of 11

http://office.microsoft.com/en-us/excel-help/apply-data-validation-to... 10/13/2013



Apply data validation to cells - Excel - office.com page 11 of 11

http://ofFfice.microsoft.com/en-us/excel-help/apply-data-validation-to... 10/13/2013



search results for - support - office.com page 1 of 1

Didn't find what you were locking for?

http://office.microsoft.com/en-us/support/results.aspx?ctags=CH006252820 10/13/2013



SWEN NOA

GL0Z1 3 L2 §.'6 3 jlews Alisgasoos SliIH PIOXB A
009y 3 8 5.6 3 flewg Alegesoon 81RISH HI0D
05ve 3 9 GG E ewsg Ausgesoony youey Aesaddiy

1zitel ] Ajuenp B0Ud 1N azIg wep jo adhy ||gen werp

[{BIUS $pBOL /|3 puB
ALIDGRSO00Y SPRAI £ 16 190D

©jewg Aliseso0g)

 Ioge wep

07V 1190w smifog
swef Ausgesood
jews Sunsty opqer v

e 0181 3
91191y 01 pardos 098L 3
2 1V W S[9GR] By, 060l 3
SL29l

SLozk

5189

0069

009y

0s'ze

0099

05ve

Je Aoy
. : Je Ay
T Rusgesoogy. sue ALBY:
ksgoe s popom.
ey PRUREEI
LNlews  AlegesooD; - S|IH PIOXaM:
) qegnyy  oieisT Aemieny

30 Ausmioelg o218 Aemien):

" Aiisgescos 193 %05
T ieanuy uouey Aieieddy
Ausgyorig Uyouey Aeseddi]
TRuegesoosy’ youey Aesdddy)

lief jo odKL  joqe uer

N

WOw W W W ww




aweN INoA

swrel AusqydBq JO IdquUn
1810} DU} SANEMO[RD 1043
UOOUTY B SUTBIUOD [[3]

§ UWTjod Ul Ppaisius ae

qieqnuy pue Auagyorg

‘AIEGOSO0Y AJU() 210 pueis

1BI0 ] qieanyy

s Auegesoc
ejo ) Adsmpioelg
Ausgorig.

- Ausgoelg:
| husgyoeig:
Alamyoeig:

Iopio Surpusose i wel
40 sad&y Ag pepos st ajqRY, llews
I whipap
fleuig

SUWIB( S POAES ST ]I ¥IB(]

| GeEdnuY
QIBONU:

- Gegnuy
L _Gieanyy
\, 01 Auisgasoon.
Ai18gasoon,

 wer Jo adAy

sugT Aley

SiH PIOXEM
212183 ABMiBD)
youey Aeseddi
aue Aoy

SiliH PIOXE M
212183 IO

uyouey Aresaddi]

sueT Ay

 SliH piopem,
818 Aemen)

 youey Aeseddy]

oaen wer



BUIBU INDA

{199 Ut paojue 10 1190 UL oquiny
3010AUL DY} U0 PosEq

PIO] O} SADLAI O] LU0 I9QLUNN
; N

nond oL dIYOOTA Sa10AU] 2y W sFe)
SRS B SUIRIUOD [{N) [[3) ¢ F0p puw 180 JO 1squing

24} SMOYUS [RIOIGNS Y

$ BLLET

4

0102/L/01 0L02/SL/0L> 662

, IO JDquir
ao10aUy] o1y v 88wy
Fop pue 185 J0 QN
2U1 SMOUS [BIOINS v

STC 1120 W aprl
$1 A1Ua pHEAm
uw j1 sieadde
afessow Jous uy

wadde 0107/12/01
U0 IO U0JG PUE OT07/1/01
IOUR IO U0 SRP IBPIO ON

sapy



ooy . S {BUOSIBA OL0OZ/L/0L 188 siroiue LBy

001 5 [BUOSIBY LOZ/0E/B GOy LR
0604 IS Hoog L0786 SN0 AIOISIY TUDULIB A SIBIOS 1599
008" 8 3o0g 0L0Z/L/6 SHOOY HorgIsted SIBPEBY
0BEZ $ Bunpojo 01027778 SPIYS-) BAsals BuoT | 1s0g
00%°2 % Bugon p1oz/es6 BUIS-] BABB(S WOUSG BUE | JUBANOG
4 $ poo4 0L0Z/E/6 isiem pajlog
1P AiobBaen apeq EEECH] AOPUS A

HIon-1

4107

APV I QGO 6 DI0JIG
sorep Bulasy poo1s veg
kuaﬁo.mm SIOPIO SPIIDDE D[GE Y

A $ fejo) puelg
0Le's . $1e10] [pUOSiad
, L8 BUOSIBE 0LOZ/0E/6
DOULS wey Eend Jom s1pio $ 2U0SI8d 0102/62/6
DSOUM PUL D OTA /6 DI0JDQ 918D UM m JeuosIag Qeom\ww\@
SPROBIT POURLXD RRY 101 DOOURAPY Uy w BUOSIOG 01021/ 2/8
3.
$
8 . Pood 010e/6/6
8 P00 0L0TIT/B
POYRAID
SUoYy wiep
S oy

(20} punid

O PUR [RIOWYNS
W saURY
Awdares Auo
shupdstp sumng

OguAs § o o Sepao
piw soseid RSP OU (M MMHMMMMH ST sthus ‘eaees BloT
FumoooE 30§ POLIEULIO Lomai STIYS-] DA8H)S oS
70 ([0 UL PAINUD M poLos . o

00180 2 H0) pUno} U CLAN
SHNoU mﬁmﬁnﬁ. CCC&ZS@
NS B SEINeD TH 1D

POIEDID ST SOLIUD
Lofsyes Supoinsal
aMop-darp J190-ut iy

Slapeny
JOPUBA.




